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1. Introduction to Kernel Office 365 Migrator for Lotus Notes

Welcome to the user manual of Kernel Office 365 Migrator for Lotus Notes, a powerful email migration tool to
migrate Lotus Notes NSF and Domino files to Office 365 mailboxes. This user manual comprises step-by-step
guidelines on using Kernel Office 365 Migrator for Lotus Notes software.

1.1 Using this Manual

This user manual is intended to guide users on using Kernel Office 365 Migrator for Lotus Notes software. We
suggest that first time users should read this user manual completely and carefully before proceeding to use the
software. However, if you are an experienced user, you can use the Table of Contents to find out information
about the tasks that you need to perform while using Kernel Office 365 Migrator for Lotus Notes software.

You can use the Table of Contents to navigate through different sections of this user manual. The Table of Contents
enlists all the sections contained within this user manual in chronological order. This user manual comprises
following sections

* Introduction

Getting Started

* Software Interface

e Using Kernel Office 365 Migrator for Lotus Notes
*  Migrate NSF File(s) to Office 365

*  Migrate Domino Server File(s) to Office 365

* Use of CSV for Advanced mapping

*  Support

* Troubleshooting

* Legal Notice

1.2 About Kernel Office 365 Migrator for Lotus Notes

Kernel Office 365 Migrator for Lotus Notes is an eminent email migration software that allows migrating Lotus
Notes NSF and Domino Server files to Office 365 mailboxes. This reliable and high-performance software lets you
migrate Domino Server and Lotus Notes NSF files to cloud and accesses them using any web browser from
anywhere even on the move. The software supports direct migration from Lotus Notes to Office 365 and helps to
migrate mailbox items such as user's emails, calendars, address books, appointments, tasks, sent items, drafts,
journals, calendars, and every other folder and item existing in the user's Lotus Notes account.
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The software facilitates migrating single as well as multiple NSF files at a time to Office 365 without any risk of
losing mailbox contents during migration. The software performs the smooth and accurate migration andmigrated
items are available in Office 365 mailbox in original format. Helpful to both administrators and individualLotus Notes
users, Kernel Office 365 Migrator for Lotus Notes allows organizations in switching from Lotus DominoServer to
Office 365 without any glitch.

Kernel Office 365 Migrator for Lotus Notes is available as an evaluation version to let users analyze its capabilities
and accuracy of email migration before deciding to purchase full version. Fully functional free trial version works
exactly like that of the full version but has a limitation that it migrates 10 emails per folder for each NSF file.
Purchase full version of Kernel Office 365 Migrator for Lotus Notes to save the entire folders with complete emails
and other items to Office 365 user profiles.

Salient features of Kernel Office 365 Migrator for Lotus Notes include:

*  Facilitates migrating multiple Lotus Notes NSF files to Office 365

* Allows migrating all Lotus Notes contents into Office 365 and enables users to edit Lotus Notes or Office 365's
folder name as required

* Can be easily connected to the Lotus Domino Server and migrates NSF files from Domino Server Mailbox(s) to
Office 365 mailbox

*  Supports UNICODE character conversion

* Provides three useful options to save the converted emails in three different text formats:
* Save item(s) in TEXT/HTML format- Fastest Speed

* Save item(s) in RTF format- Low Quality - Medium Speed

* Save item(s) in RTF format - Best Quality - Lowest Speed

* Efficiently converts all items from Lotus Notes NSF and Domino Server files including emails, attachments,
contacts, calendars, appointments, journals, to-do item list, sent mails, drafts, alarms, rules, group calendars,
created categories, and every other folder.

* Supports every version of Lotus Notes and Domino Server to perform the process of file conversion.

Now that you have understood the features and potential of Kernel Office 365 Migrator for Lotus Notes, you are
ready to get a hand on experience of the software. To start migrating Lotus Notes NSF and Domino Server files to
Office 365, you will first need to download and install this software.
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It is strongly recommended that before installing Kernel Office 365 Migrator for Lotus Notes, you should go
through the installation pre-requisites for the software to ensure that your computer is appropriately configured
to run the software.

2.1 Installation Pre-requisites
Following are the basic system pre-requisites to perform successful migration of Lotus Notes NSF and DominoServer files
to Office 365 using Kernel Office 365 Migrator for Lotus Notes:

2.1.1 Hardware Requirements:
The hardware requirements for installing the software are as follows:

* Pentium Class Processor

* 64 MBRAM (128 MB Recommended)
e 25 MB for Software installation

* Disk Space - Enough space to save the results

2.1.2 Software Requirements:
Supports MS Windows Operating System (Both 32-bit and 64-bit): Windows XP, Windows Vista,
Windows 7, Windows 8, Windows 8.1, Windows 10, Windows Server 2000, Windows Server 2003,
Windows Server 2008, Windows Server 2008 R2, and Windows Server 2012.

Supports Lotus Notes versions: Lotus Notes 6.5, Lotus Notes 7.0, Lotus Notes 8.0, Lotus Notes 8.5, Lotus
Notes 9.0, Lotus Notes 10.0, IBM SmartCloud Notes, IBM Verse.

Supports Domino Server versions: Domino Server 6.5, Domino Server 7.0, Domino Server 8.0, Domino Server
8.5, Domino Server 9.0 and Domino Server 10.0.

™. Lotus Notes and .NET Framework 4.0 must be installed on the system from which you are
performing the email migration from Lotus Notes NSF and Domino Server file to Office 365. ™=
Domino Server should be in working condition while migrating Domino Server files because
Kernel Office 365 Migrator for Lotus Notes software needs to be connected with Domino Server
for its functioning.

2.2 Downloading Kernel Office 365 Migrator for Lotus Notes for the First Time

After checking your computer with the prescribed system requirements for Kernel Office 365 Migrator for Lotus
Notes, you can download the evaluation version of the software on your computer using the following link:

https://www.nucleustechnologies.com/lotus-notes-to-office365.html :
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X The free trial version of Kernel Office 365 Migrator for Lotus Notes efficiently migrates 10
emails per folder for each single NSF file. To migrate all mailbox items of Lotus Notes
without any restrictions, purchase the full version of the software.

2.3 Install Kernel Office 365 Migrator for Lotus Notes

To install Kernel Office 365 Migrator for Lotus Notes onto your computer system, perform the following  steps:

1. First, make sure that the host computer meets the entire basic system requirements and has sufficient
memory available.

2. Download Kernel Office 365 Migrator for Lotus Notes from the website:

https://www.nucleustechnologies.com/lotus-notes-to-office365.html

3. Double-click Kernel Office 365 Migrator for Lotus Notes software Installer .exe file.
4. Follow the on-screen instructions. The setup install completion screen will be displayed.

5. Click Finish, the main window of Kernel Office 365 Migrator for Lotus Notes will be launched

2.4 Start Kernel Office 365 Migrator for Lotus Notes

To start Kernel Office 365 Migrator for Lotus Notes software:

* Click Start > All Programs > Kernel Office 365 Migrator for Lotus Notes

Alternatively, you can launch Kernel Office 365 Migrator for Lotus Notes by double-clicking the shortcut icon
available on the desktop and Quick Launch icon.

2.5 Uninstall Kernel Office 365 Migrator for Lotus Notes

You may need to uninstall and re-install Kernel Office 365 Migrator for Lotus Notes. To uninstall Kernel Office 365
Migrator for Lotus Notes software,

1. Click Start > All Programs > Kernel Office 365 Migrator for Lotus Notes > Uninstall Kernel Office 365 Migrator for
Lotus Notes

A warning message will be displayed.

2. Click Yes to uninstall Kernel Office 365 Migrator for Lotus Notes.

= Before proceeding to uninstall Kernel Office 365 Migrator Lotus Notes, you must ensure that
the software is not running.
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You can alternatively uninstall Kernel for Lotus Notes to Office 365 from the Control Panel by performing the following
steps:

1. Click Start > Control Panel and then double-click Add or Remove Programs icon.

2. Select Kernel Office 365 Migrator for Lotus Notes and click Remove.

3. A warning message will be displayed. Click Yes to uninstall Kernel Office 365 Migrator for Lotus Notes.

3. Software Interface

Now that Kernel Office 365 Migrator for Lotus Notes has been installed on your computer, you can start using the
software after getting acquainted with the software interface.

@ Kernel Office365 Migrator for Lotus Notes -0
File Tools Help
m ® 13 KeErRNE l Office365 Migrator for Lotus Notes
) L \ S o -
(5 Step 1 71F Add Local NSF file(s) ‘ ‘].r Add Domino Server| | #%  SmartCloud Notes/Verse | | Remove ‘ | Preview
Please select NSF file(s) . = /K /X
or Domino file(s) to File Path IP Address/Server Name
convert
Step 2
Step 3
Kernel
Migrate
www.nucleustechnelogies.com CAP |[NUM [SCRL
Figure 3.1 Welcome screen of kernel Office 365 Migrator for Lotus Notes
3.1 Menu bar

The menu bar of Kernel Office 365 Migrator for Lotus Notes comprises three main menus — File, Tools, and Help.

3.1.1 File Menu

The File menu of Kernel Office 365 Migrator for Lotus Notes appears as:
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Eiié Tools Help
Jit Add File(s)

it Add Domino File(s)
E Migrate

& Exit

Figure 3.2 File Menu

Menu items in the File menu:

Field Name Field Description

Add Local NSF File(s) Select to add NSF file(s) for migration

Add Domino File(s)
Add Domino Server File(s) for migration

Migrate Select to start the migration process

Exit Select to close Kernel Office 365 Migrator for Lotus Notes software

3.1.2 Tool Menu

The Tools menu comprises one menu item.

Tools Help
{2} Advance Settings
Figure 3.3

Menu item in the Tools menu:

Field

Field Description
Name

Select this option to access ‘View Folders’ which are by default created by Lotus Notes. To

Advance
Settings view them, you need to activate the ‘Show View Folder
© KernelApps Private Limited RETNEL 7
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option from the Advance Settings window.

Advance Settings

[] Show "View Folders"

Edit Folder Name
Edit Name of Lotus Nates folders to be migrated to Office365 mailbox.

I AddNew Folder | | UseDefault |
Default Lotus Notes Fol... | Lotus Notes Folders E Office365 Folders i
Inbox Inbox Inbox
Drafts Drafts Drafts
Sent Sent Sent ltems
Trash Trash Deleted Items

SBC ®YZ
oK Cancel

Figure 3.4 Advanced Settings

3.1.3 Help Menu

The Help menu comprises three menu items:

Help
© Hep
& Software home page

& About Kernel Office365 Migrator for Lotus Notes
Figure 3.5 Help Menu
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Menu items in the Help menu:

Field Name Field Description

Select to open User Help Manual of Kernel Office 365 Migrator

Help
for Lotus Notes software
Software home page Select to visit software homepage on our website
About Kernel Office 365 Migrator Select to know version and support information about

Kernel for Lotus Notes Office 365 Migrator for Lotus Notes

software

3.2 Toolbar

The toolbar in Kernel Office 365 Migrator for Lotus Notes software contains following buttons:

Button Button Description

Click to add and list Domino Server to Kernel Office
365 for Lotus Notes software for migration.

’ 7ir Add Domino File(s) ‘

‘ Click to remove NSF files that have been added before the

’. Remove migration starts.
- ) Click to preview NSF files that have been added before the
’ Preview ‘ migration starts.
( ; ) Click the start the migration from NSF to Office 365.
‘ Migrate ‘
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@ Click this button to view Kernel Office 365
Migrator for Lotus Notes software's home page
on our Website.

Click to add and list local NSF file(s) for migration.

l 74T Add Local NSF file(s) ’
\ / Click this button to know version and support

@ about Kernel Office 365 Migrator for
Lotus Notes software

=

Click this button to buy the complete version of
Kernel Office 365 Migrator for Lotus Notes

4. Using Kernel Office 365 for Lotus Notes Software

Kernel Office 365 Migrator for Lotus Notes software can be used for two methods — Migrate NSF file(s) to Office
365 and Migrate Domino Server files to Office 365. Another method to include NSF file to migration is the use of
CsV file.

4.1 Migrate NSF file(s) to Office 365

Let’s see how Kernel Office 365 Migrator for Lotus Notes software performs the NSF files to Office 365 mailbox
migration -

Step 1: Launch Kernel Office 365 Migrator for Lotus Notes software and click the first option to Add Local NSF file(s).
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|K] Kernel Dffice365 Migrator for Lotus Notes M= B
J Eile  Tools Help

J ﬁ (D KernN El Office365 Migrator for Lotus Notes

@ St 7§t Add Local NSF file(s)
Flease select MSF file{s) or
Doming file(s) ko convert

Ay
71t Add Domino Server| “#% smartCloud Notes/Verse |

Remove ][ Preview

File Path | 1P Address/server Name |

Step 2

Preview Emails of NSF
database {in case of single
MSF file selection only)

Step 3

Select and Save folder in
Office365 User Mailbox

KerRNE

m

iy nucleustechnologies, com WW!ﬁ 4
Figure 4.1 Home Screen

Step 2: Browse the number of NSF files to migrate. Selected NSF files will get listed in the Kernel Office 365 Migrator
for Lotus Notes software for migration.

_'K_‘_Kernel Dffice365 Migrator for Lotus Notes - O] =
J File Tools Help
J m @ KErRNE l Office365 Migrator for Lotus Notes
(.. [ )
5 Step 1 Tir Add Local N e file(s) Verse Remaove Preview
Flease select MSF file{s) or —
Dorrine filefs) to careert Fieran  Lookin I- Deskiop j G 5 |
test =
' File Folder —I
Step 2

ATestMailbox_to-ce
M IBM Potes database

Preview Emails of MSF
database {in case of single
MSF File selection anly)

26,2 MB

Step 3

£
File name: Isadmmls Open I
Files of tupe: INSF File[* naf) j Cancel |

Select and Save folder in
Office365 User Mailbox

4

v, nucleustechnaologies .com WWlﬁ 4
Figure 4.2 Selection of NSF files
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Selected NSF files will get listed in the Kernel Office 365 Migrator for Lotus Notes software for conversion.

Step 3: Select any NSF file and click the Preview button.

]B_]:Kernel Office365 Migrator for Lotus Notes

JFI\E Tools  Help

J TEF @ KerNE l Office365 Migrator for Lotus Notes

. . p— . .
@ Stert 70t Add Local NSF ﬁle[5)| 7it Add Domino Server‘ ‘“ﬁ' SmartCloud Notes/Verse | | Remove | m

Please select WSF file(s) or -
Domino filels) ko convert

File Path IP Address/Server Name

i o \Userst AdministratoriDesl

plsadminis.nst

Step 2

Preview Emails of NSF
database {in case of single
MSF File selection only)

Step 3

Select and Save folder in
Office365 User Mailbox

KernEL —
‘ Migrate ‘
iy nucleustechnologies.com WW SCRL %

Figure 4.3 Click Preview button

Step 4: The tool is fetching the data of NSF file. You can check any item and its preview will be presented in preview
pane below it.

[K] kernel Office365 Migrator for Lotus Notes [_T0]x]
J File  Tools Help
j@ @ KER NE l Office365 Migrator for Lotus Notes
v Ferl ¥ Show "View Folders"
Please select NSF file(s) or
Domina file(s) ko convert: é 'JEIEE ; = From Subject Date Size in Bytes Attachment | i’
ELJ (;Le:tliilgsnllByDa Santosh Test mail 15-11-2018 01:06:58 PM | 750
o Step 2 O ($MeetingsOnMyC: L3 5antosh Test mail 15-11-2018 01:06:58 PM | 731 LI
Preview Emails of MSF D‘:‘E Calendar
database {in case of single 3 ELJ E:PEBPIEG')‘DUPSFIB Test mail
MSF File selection anly) -3 ($POP3UIDL; b o
= Santosh Ad trator/dy9
-7 ($POP3) antosh Administrator/dy 15-11-2018 01:06:56 PM
-~ (§Profiles) . .
Step 3 O (Repeatlockup) Email ltem
Select and Save Falder in 0.5 sent
OFfice365 Liser Mailbox D (4softDeletions) Sut_lject: Test mail
- O13 ($ThreadsEmbed) MailDate: 15-11-2018 01:06:58 P
003 Tobo From: Santosh Administrator/dyd
O Trash SendTo: Santash Administratondy3@dyd
l -1 fdTMInnY &2 hi
Kermel o — 7T =
Back | | Migrate |
wan nucleustechnologies.com [CAP UM |SCRL gz

Figure 4.4 See the NSF File Item
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Step 5: After viewing, click Back option to get to the list of added NSF files. Then click Migrate button to initiate the
migration procedure.

|[K] kernel Office365 Migrator for Lotus Notes [_ O[]
J File  Tools Help
‘ m @ KE RMN El Office365 Migrator for Lotus Notes
.y ) ., -\.‘ ! ‘-
@ Step 1 [‘l“’ Add Local NSF ﬂJe(s)J 7ir Add Domino Server| | #%" smartCloud Notes/Verse | l Remove J m
Please select WSF file{sd or L

Doming filefs) ko corvert

File Fath

IP Address{Server Hame

s AdministrakorD phsadminis, nsf
Step 2

Preview Emails of NSF
database {jin case of single
MSF File selection only)

Step 3

Select and Save folder in
Office365 User Mailbox

KernEl

wiww, nucleustechnologies .com WW’E 4
Figure 4.5 Click Migrate button to start migration

Step 6: Choose the ‘Migrate Type’ and ‘Migrate To’ option, then input the User email ID and Password of Office 365. Then
click OK.

K] =
Eile Tools Help
Gj' @ KerNE | Office365 Migrator for Lotus Notes
@ Ste! Office 365 Login Details s L Notes/Verse ‘ ‘ Remove Preview

Please select NSF file(s)

et J Office 365
W C:\Users\Win Login
Step 2 i CAUsers\Win Migrate type Migrate to
@ Maibox (O Single Mailbox
(O Archive Mailbox (® Multiple Mailboxes
(O Pubic Folder

Step 3
O Microsot 365 Group

Dffice 365 Credential
Select Server. | outlook. office365.com b

User ID
Note : Use global administrator for multiple mailbox migration

116 MFA is enabled then use App Password in password field  ( How to generate App Password )

Password : ‘

[[] Check to assign Impersanation Rights of  ( Execute the PowerShel command manually )

o | o]

Kernel

Migrate |
www.nucleustechnologies.com CAP |NUM |SCRL

Figure 4.6 Input Office 365 Credentials

. - [KERNEL A
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Step 7. Mapping page is opened. Select the second option of Map automatically and click the Get Target Mailbox(es) List.
It will automatically map the NSF file with its respective Office 365 mailbox. You can manually map the NSF file with
Office 365 using the Mapping button. Also, you can save the mapping details to CSV format.

Mapping n

() Map using CSV Download sampl v

(®) Map automatically

Get Target Mailbox List

" Mapping | Impost from CSY Export to CSV
File Path Source Madbox Target Mailbox Target Email
D:\megha\experiment fles\test file.nsf  test file
D:Amegha‘\experiment files\insf file. nsf nsf file :
D:\megha\experiment files\LAB-TEST... LAB-TEST S |
< >
0K Cancel

Figure 4.7 Perform mapping of NSF files with Office 365

. . [KERNEL A
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Step 8: The Set Filter Window has multiple filter categories on which you can apply the appropriate data. The Filters are like-

= Date Range — Choose a start date and end data to migrate the data between the range.
= Select Categories — There are several categories like Mails, Contacts, Calendar, Calendar, Tasks.

= Do not allow duplicate items — Stop the duplicate items of NSF file from migration.
=  Folder Mapping — This feature allows you to map the source and destination folders.

=  Skip Folder name “All” — Select this checkbox to ignore folders with name “All” for migration.
= Skip Hidden Views and Folders — Select this checkbox to avoid migration of hidden views and folders.

= Exclude Folder(s) - Write name of the folder which you do not want to migrate.
* Include Folder(s) - Write name of the folder which you want to migrate.
= Select if you want to save all data hierarchy into a new folder - save complete NSF files in a single root folder.

After applying all the filters on the NSF file data, you need to click OK button.

Please select a date range to migrate item[=).

set Filters E3 |

— ¥ SetDate Range

[04-5ep-15 =

Start Date :

End Date : |2F"-Dec-1 q ;I

Insert date === |

Start D ate

| End Date

04-Sep-16

Femove | 4|

27-Dec-19

| 2]

W Contacts

Select Categories
[ ¥ Mailz

W Calendars

[V Taszks

<

[+ Do ot allove duplicate items

Settings |

¥ Folder Mapping

<

<

W Skip folder name ' a0 Q W Skip Hidden Yiews and Folders e.g. [

Hel

<

Inzlude # Exclude Folders

o)

Exclude Folder(s) : I

[E.q. falder] folderZ,..etc. For zub folder : parent folderhaub folder. ]

7 Include Faolders] ; |

[E.qg. folder] folder2,. etc. For sub folder : parent foldert=ub fu:nlu:ler.]I

W Select if you want to save all data hierarchy in o a new folder.

IHEW

Ok | Cancel I

© KernelApps Private Limited
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Step 9: Now select the best suited saving mode for your migration.

_:K_ | Kernel Office365 Migrator for Lotus Notes

JEi\e Tools  Help

It ©
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KerNE l Office365 Migrator for Lotus Notes

V Step 1
Please select MSF File(s) or
Domino file(s) to conwvert

Step 2

Preview Emails of NSF
database (in case of single
WSF file selection only)

Step 3

Select and Save folder in
Officed6s User Mailbox

..K

’E RN,

v nucleustechnologies.com

Saving Mode Selection

Please select saving mode, RTF format may take more time in saving

& Save item(s) in RTF format - Best Qualiy - Lowest Speed
€ Sawve itemls) in RTF format - Low Quality - Medium Speed

€ Save itemls) in TEXT format - Fastest Speed

 Specify read and unread message marks,

' Mark all message as unread

' Mark all message as read

Preview

[cap oM [ScRL

Step 10: Migration is started.

]Eile Tools  Help

at ©

Figure 4.9 Select Saving mode

KERNE l Office365 Migrator for Lotus Notes

V Step 1
Please select MSF file(s) or
Domino file{s) bo convert

File Mame Status

| IP Address|Server Name |

i ;|\ Usersiidministrator|Desktoplsadminis. nsf Processing...

Step 2

Preview Emails of MSF
database {in case of single

Saving Folder (By Company ...

MSF File selection only)

Step 3

iew Migration Logs

Select and Save folder in I

100% Saving Item S of 5 ..,

Office365 User Mailbox

I 3% Saving Folder 2 of 55 ...

I}(E RIN

im

A nucleustechnologies, com

Step 11: Lotus Notes to Office 365

© KernelApps Private Limited

Figure 4.10 Migration is started

migration is completed.
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_:K. | Kernel Office365 Migrator for Lotus Notes

JEi\e Tools  Help

J ﬁ ® KErRNE l Office365 Migrator for Lotus Notes

V’ Step 1
Please select WSF files) or
Domino filefs) ko convert

Step 2
v

Preview Emnails of NSF

database {in case of single . " "
WSF File selection only) SV Ra IS K ernel Office 365 Migrator for Lotus Notes [x]

Step 3 b Saving Complete
6 | Click Mext button bo migrate anather file or click Exit o cose the
Select and Save folder in T oftware
Officedss User Mailbox

Ke

i
-
2
2
.
HER
—

wiww nucleustechnologies .com W’m,ﬁ 4
Figure 4.11 Migration is successful

4.2 Migrate Domino Server file(s) to Office 365
Step 1: Launch Kernel Office 365 Migrator for Lotus Notes and click Add Domino File(s).

[K] Kernel Office365 Migrator for Lotus Notes M=l
J File Tools Help

Jm ® KerRNE l Office365 Migrator for Lotus Notes

g Stert FH AL SIS SISO 33t Add Domino Server
FPlease select NSF file(sd ar

O Fil ki t
ormino file(s) ko conver! File Path I 1P Address(Server Name I

vy ‘

“#% smartCloud Notes/Verse

Remove ] [ Preview

Step 2

Preview Emails of MSF
database {in case of single
MSF File selection only)

Step 3

Select and Save folder in
Office365 User Mailbox

K'_‘E RIN|

v nucleustechnologies. com ,@W’ﬁ 4
Figure 4.12 Add Domino Server File(s)

) o KERNEL &
© KernelApps Private Limited DATA RECOVERY



19

Step 2: In Domino Server File Selection wizard, you can input either server name or the IP address of Domino Server.
Then click Add Domino Server.

Domino Server File Selection %]

— Step 1: Find or A4dd the Domino Server Name , Then select the Domino Server Name from the list

|1 92.168.10.11§ Add Domino Server

Domina Server IP Address/Domino 5... | =

Search Domino Server I

— Step 2: Select the nsf files belonging to the selected Domino Server and click Add button

Select Al Unselect All |

Domino Server NSF File(s) l

Add Cancel Finish ]

Figure 4.13 Add Domino Server via IP or network name

Step 2.1: If you are not sure about Domino Server name or IP address, then you can choose to use the Search Domino
Server feature. It will search all the available Domino Server in your network.

. - [KERNEL A
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Domino Server File Selection [ X I

— Step 1: Find or Add the Domino Server Name , Then select the Domino Server Name from the list

l Add Domina Server '

I

Domina Server IP Address/Domino S... I

Search Domino Server |

—Step 2: Select the nsf files belonging to the selected Domino Server and click Add button

Select Al Unselect All |

Domina Server NSF File(s) |

Add Cancel Finish

Figure 4.14 Search Domino Server

Step 2.2: A pop-up message will inform you that enumeration of Domino Server may take several minutes. Click Yes
to go ahead.

. - [KERNEL A
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Damino Server File Selection x|

~ Step 1: Find or Add the Domino Server Name , Then select the Domino Server Name from the list

I &dd Domino Server |

Domino Server IP Address/Domino S... l

The enumeration of server information can take several minutes I

Do you want to enumerate the server now?

~Step 2: Select |

Se

D ominor-oerverrear-rrersy T

#dd Cancel Finish

Figure 4.15 Enumeration of Domino Server

Step 2.3: After completing the search, the tool will list down all the Domino Server in the network. Select any Domino
Server.

. . [KERNEL A
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~ Step 1: Find or Add the Domino Server Name , Then select the Domino Server Name from the list

I B8dd Domino Server I

Domina Server IP Address/Domino S... I

CN=D0MINO-9FPC/0=DY39 [a

Flease wait while
finding NSF file in
server

Stop l

~ Step 2: Select the nsf files belonging to the selected Domino Server and click Add button
Select Al UnselectAll |

Domino Server NSF File(s) I

Bdd Cancel Finish

Figure 4.16 Select Domino Server

Step 2.4: As soon as you select a Domino Server, all of its NSF files will be presented in a list. You can easily select or
deselect any number of files.

© KernelApps Private Limited n;fngc'oiige



~ Step 1: Find or Add the Domino Server Name , Then select the Domino Server Name from the list

Domino Server IP Address/Domino S... l
CN=DOMIND-SPC/0=DY9

Add Domino Server I

"

Search Domino Server |

~ Step 2: Select the nsf files belonging to the selected Domino Server and click Add button

Select Al Unselect Al |

Domina Server NSF File(s) I

schema.nsf
reports. nsf

[[] PwdResetS ample.nsf
names.nsf

1 mail\sadminis.nsf

[ loa.nst

Add | Cancel Finish
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Figure 4.17 Select or deselect NSF file

Finally, click Add button.

Step 2.5: Another pop-up message will inform you that if you want to add more NSF file using different Domino Server,

then you can select that Domino Server and include its files also. click OK.

© KernelApps Private Limited

[KERNEL 4
DATA RECOVERY



24

Darning Server File Selection .

~ Step 1: Find or Add the Domino Server Name , Then select the Domina Server Name from the list

I Add Domino Server I

Domino Server IP Address/Domino S... ] ‘
CN=DOMIND-SPC/0=DY9 @

Selected file(s) are added, If you want to select file(s) from other :
Domino Server then click on that Domino Server Name in the list or nina Server I
click on Finish button to proceed with the Migration process.
~Step 2: Selec
OK I
D ommro-oerverrear-rersy 1 =
schema.nsf =

reports. nst

[[] PwdResetSample.nsf

names.nsf

] mail\sadminis.nsf

[ log.nsf Ll

Add Cancel Finish

Figure 4.18 Select more NSF files from other Domino Server

Step 2.6: After selecting all the desired NSF files, please click Finish.

. . [KERNEL A
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~ Step 1: Find or Add the Domino Server Name , Then select the Domino Server Name from the list

Domina Server IP Address/Domino S... ]
CN=DOMIND-SPC/0=DY9

Add Domino Server I

"

Search Domino Server |

~ Step 2: Select the nsf files belonging to the selected Domino Server and click Add button

Select Al Unselect Al |

Domino Server NSF File(s) l

schema.nsf
reports.nsf

[[] PwdResetS ample.nsf
names.nsf

1 mail\sadminis.nsf

[ loa.nst

Cancel Finish
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Figure 4.19 Click Finish

Step 3: NSF files are successfully included as the source. Now, click Migrate button to export it to Office 365 platform.

© KernelApps Private Limited
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K| Kernel Dffice365 Migrator for Lotus Notes

Be Took b
m @ Kern El Office365 Migrator for Lotus Notes
stept i Add Local NSF file(s)| | i Add Domino server| |8 smartCloud Notesiverse Remove | | Preview
Fesse st S Hes) o L i
et I |
S names.rsf CN=DOMIND-SPC/O=DY9
W maisadmis. et CN=DOMINO-PC{O=DY9

Kernel
Migrate
wnann el stehrologies. com a5 ham ficeL

Figure 4.20 Click Migrate button

Step 4: Input user ID and password of destination Office 365 account. It will open the Mapping window. Click OK.
B Kermel Office365 Migrato Jtus Notes Ver 21.0

File Tools Help
at ®

@ Str! Oftlce|305 Loghn Desalls . h Notes/Verse | { Remove | [ Preview
Please select NSF file(s)
or Domino file(s) to

File ath 1] Office 365
Login

KErRNE I. Office365 Migrator for Lotus Notes

Wi C:\Users\Wing
Step 2 Wi C:\Users\Win

Migiate type Migrate to
Previ @ Miaibai O Single Maibox
gle NS on O Auchive Maibax @ Mulliple Mailboxes
only © Publc Folder

folder ir O Microsoft 365 Group

Office 365 Credential
Select Server.  outlook office365.com i

UserID \ |
Mote : Use global administrator for multiple mailbox migration

[C11F MFA is enabled then use App Password in password field  ( How to generste App Password )

Password ; ‘ |

[ Check to assign Impersonation Rights o ¢ Execute the PowerShell command manualy )

0K Cancel

Kernel

Migrate

www.nucleustechnologies.com CAP |NUM |SCRL

Figure 4.21 Input Office 365 login credentials
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Step 4.1: In the Mapping window, select the second option of Map automatically and click Get Target Mailbox(es)
list button. The tool will search all mailboxes of respective Office 365 account and will automatically map such

account which have same name as the source NSF file.

J File Tools Help SEERS
" Map using CSV Download sample C5Y \
J@ @ R | €| office3ss Migrator for Lotus Notes
& Map automaticall :
o Step 1 Get Target Mailbox List [ Remove 1 [ Praview
Please select NSF file(s) or Mapping I Impaort from CSY | Export to CSY |
Domino file(s) to convert m l
|=———— | File Path I Source Mailbox I Target Mailbox ] Target Email
3 names
names.nsf names
WF reports
reports.nsf reports
Wr schemé
schema.nsf schema
< | i3
= =
Igrate
0K | Cancel I
www,nucleustechnologies.com

Figure 4.22 Map target automatically

Step 4.2: Click Mapping button to manually map the NSF files to Office 365 account.

[car [wom [scrL

K, Kernel Office365 Migrator for Lotus Notes Y (=] B3

[ ook ek
M ing CSY Download sample C5Y . .
}‘G} @ SRR El Office365 Migrator for Lotus Notes
& Map automatically
° Step 1 Get Target Mailbox List [ Remove ] [ Preview
Please select NSF file(s) or I Mapping I Import from CSY I Export to CSY [
Domino file(s) to convert m I
== [TFile Path [ Source Maibox [ Target Mailbox [ Target Email
\ll L names.nsf names
W reporte
reports.nsf reports
Wr schem:
schema.nsf schema
«| | |
Y = =
KernEL ,
Migrate
oK I Cancel I
wiww, nucleustechnologies. com WNUM SCRL 4
Figure 4.23 Click Mapping button for manual mapping
. . . rg==1v ®
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Step 4.3: Select any account and click OK.

Mapping

() Map using CSV Download sample CSV

®) Map automatic. Select Target Mailbox(es)

| GetTaget
\Exportto CSY |
Source Mailbox :test file

File Path Target Email
Target Mailbox Target Email A

sh.onmicrosoft....
tech.onmicroso...
:ech.onmicroso...
satech.onmicro...
siyatech.onmi...
=

sh.onmicrosoft....
Agiyatech.onmi...
:h.onmicrosoft....
nmicrosoft.com
=ch.onmicrosof...

5 ok Cancel

0K | | Cancel

Figure 4.24 Select Office 365 account

Step 4.4: After all the NSF files are successfully mapped with an Office 365 account, click OK. The filter window will
appear.

. . [KERNEL A
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K| Kernel Office365 Migrator for Lotus Notes

: 7 = | [=] B3
[l ik ek
O M ing CSY Download sample CS5Y _
J m @ SRR | El Office365 Migrator for Lotus Notes
& Map automatically "
o step 1 Get Target Mailbox List I [ REOVE J [ Preview J
Please select NSF file(s) or Mapping | Import from CSY | Export to CSY |
Domino file(s) to convert W |
—‘.i;——— File Path I Source Mailbox I Target Mailbox [ Target Email
P name:‘ names.nsf names monica ch
ve:ort reports.nsf reports Tarun lamba .ol
W schem schema.nsf schema sudesh kumar h!
< | |
L = -
Kernel
Migrate
I oK I Cancel |
www,nucleustechnologies.com WNUM SCRL 4
Figure 4.25 Mapping is complete
Step 5: The Set Filter window has following filtering options for you to select:
il X
J Fle Tools Help Please select a date range to migrate item(s).
jm @ [V SetDate Range l
satDae: [T 5] [Ehibas [EndDa E RN E L Office365 Migrator for Lotus Notes
T T 7172015 5/17/2019 T
EndDate: 5/17/2019 |
Step 1
0 P

FiIe(s)J [ Remove ] [ Preview ]
Please select NSF file(s) or

se se | Insert date >>>
Domino file(s) to convert _Filepath —I

Wi names.nsf Remove | «| | »]
Wi reports.nsf

Wi schema.nsf

ryver Mame |

Select Categories
’V V' Mails V' Contacts [V Calendars ¥ Tasks ’

V' Do not allow duplicate items

V' Folder Mapping Settings |

[V Skip folder name " &Il @) I Skip Hidden Views and Folders e.g. [* Hel

Include / Exclude Folders

& Exclude Folder(s) : I

[E.g. folder folder2,..etc. For sub folder : parent folder\sub folder. )
€ Include Folder(s) [

:,x

NERN)

[E.g. folder folder2,..etc. For sub folder : parent foldersub folder J‘

™ Select if you want to save all data hierarchy in to a new folder. M grate

l 0K l | Cancel l [cap [nom [5cRL
Figure 4.26 Put the appropriate filter

el
0

wiww,nucleustechnologies.com

Set Date Range - Create a date range to migrate NSF files from a start date to end date.

. . [KERNEL A
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Select categories - Select from various categories of Mails, Contacts, Calendars, and Tasks.

Do not allow duplicate item — Select this checkbox to avoid migration of duplicate items.

Folder Mapping — This option allows to map and modify both source and destination folders.

Skip Folder name “All” — Select this checkbox to ignore folders with name “All” for migration.

Skip Hidden Views and Folders — Select this checkbox to avoid migration of hidden views and folders.
Exclude Folder(s) - Write name of the folder which you do not want to migrate.

Include Folder(s) - Write name of the folder which you want to migrate.

Select if you want to save all data hierarchy into a new folder - save complete NSF files in a single root folder.
After applying the filters, click OK.

Step 6: Select the most suited saving mode and click OK.

|K, Kernel Office365 Migrator for Lotus Notes _ (O] x|
] File Tools Help
J @ @ KerNE l Office365 Migrator for Lotus Notes
v Step 1 - - ’ Preview
Please select NSF il(s) or »

Domino file(s) to convert . ;3 "
Please select saving mode, RTF format may take more time in saving

v Step 2 ' Save item(s) in RTF format - Best Quality - Lowest Speed

Preview Emails of NSF
database (in case of single " Save item(s) in RTF format - Low Quality - Medium Speed
NSF file selection only)

" Save item(s) in TEXT format - Fastest Speed

Step 3
o i [~ Specify read and d k:
Select and Save folder in pecify read and unread message marks.

Office365 User Mailbox @ Mark all message as unread

¢ Mark all message as read

B4

KernEL
wiww. nucleustechnologies. com WW SCRL ¢

Figure 4.26 Select the saving mode

Step 6.1: The Migration process starts. It will display the name of current folder being migrated. You can choose to
stop the migration using Stop button.

. - [KERNEL A
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K. Kernel Office365 Migrator for Lotus Notes | _ (O] x|
] File Tools Help
‘ @ @ KerNE officesss Migrator for Lotus Notes
v Step 1 File Name [ status [ Domino Server 1P Address/Domino S... [
Please select NSF file{s) or Wi names.nsf Processing... CN=D9-SERVER/O=DMAILY
Dornino file(s) to convert i reports.nsf Pending CN=D9-SERVER/O=DMAILS
Wi schema.nsf Pending CN=D9-SERVER/O=DMAILY
Step 2
v

Preview Emails of NSF
database (in case of single
NSF file selection only) Saving Folder Server\Mail-In Databases and Resources By Categoryl,...

Step 3
0 P

Select and Save folder in
Office365 User Mailbox

| - = |

Kernel

wiww.nucleustechnologies.com CAP |NUM |SCRL ¢

Figure 4.27 Migration starts

Step 7: A message will be displayed after a successful migration. Click OK.

K| Kernel Office365 Migrator for Lotus Notes =] B3
J Eile Tools Help

j @ @ KerNE officesss Migrator for Lotus Notes

Step 1

v ]
Please select NSF file(s) or
Domino file(s) to convert

V Step 2
Preview Emails of NSF
database (in case of single
NSF file selection only) Saving Complete , Click Next button to migrate another file or click Exit button to close the software

Step 3 Kernel Office365 Migrator for Lotus Notes x|

o Select and Save folder in
Office365 User Mailbox , Saving Complete ,
Click Mext button to migrate another file or click Exit to close the
software

?&
m
)
<
)

wiw.nucleustechnologies.com WINU—M SCRL 4
Figure 4.28 Migration is successful

Hence, the Domino Server Files are migrated to Office 365 platform.

4.3 Use of CSV file for Advanced mapping

. . [KERNEL A
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In order to add NSF file, you can take assistance of a CSV file to include multiple NSF file. CSV file is used to migrate

multiple NSF files to Office 365 in one attempt. CSV file contains four columns -

NSF File Path: In the first column of CSV file, enter NSF file(s) with full path that you want to migrate to Office 365.

Source Mailbox: In second column of CSV file, enter complete mailbox name of source NSF file.

Target Mailbox: In third columns of CSV file, enter the target mailbox name.

Target Email: In the fourth column, enter the complete target email.

Here is a brief method -

Step 1: Under Mapping window, select the first option of Map Using CSV and click Export to CSV button.

| File Tools Help

at ©

Step 1

o T )
Please select NSF file(s)
or Domino file(s) to
convert

Step 2

Kernel

www.nucleustechnologies.com

() Map automatically

Get Target Mailbox List

Mapping

(®) Map using CSV Download sample CSV

[ e

ffice365 Migrator for Lotus Notes

Mapping Import from CSY I Export to CSY I emove ‘ ‘ Preview

T‘{ Export the list to CSV }Name

File Path Source Mailbox Target Mailbox

D:\meghatexperiment files\test file.nsf  test file

D:\megha\experiment files\nsf file.nsf nsf file

D:\meghatexperiment files\LAB-TEST... LAB-TEST

< >
oK Cancel l

Figure 4.29 Click Export to CSV button

Step 2: Save the CSV file at a desired location.
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INJO,

Help

o Step 1
Please select NSF file(s)
or Domino file(s) to
convert

Step 2

Preview Emails of NSF
database (in case of
single NSF file selection
only)

Step 3

Select and Save folder in
Office365 User Mailbox

Kernel

www.nucleustechnologies.com

(® Map using CSY

() Map automatically
Get Target Mailbox List

Download sample CSV

Mapping

Save As

i ———
toCSY |

File Path — Email
rere Savein:‘ | experiment files v! (<) & = @ et
D:\megha® SIS R =
D:\megha* | bkf A
i \
D:megha! 1 dbx Outlok express fles
.. EDB files
1 EML files
1! IMH files
. mbox files_thunderbird
I/ MDR i
File name: [nsfcsv I I Save |
Save as type: iCsv Files {*.csv) v ‘ Cancel ‘
< >
0K ‘ ‘ Cancel \

Figure 4.30 Save the CSV file
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ffice365 Migrator for Lotus Notes

emove ][ Preview

Server Name

Step 3: A pop-up message will inform you that mapping details are successfully exported to CSV file.

Tools

@O

Help

(5 Step 1
Please select NSF file(s)
or Domino file(s) to
convert

Step 2

Preview Emails of NSF
database (in case of
single NSF file selection
anly)

Step 3

Select and Save folder in
Office365 User Mailbox

Kernel

www.nucleustechnologies.com

© KernelApps Private Limited

(® Map using CSV

() Map automatically
Get Target Mailbox List

Download sample CSV

Mapping

Mapping

ﬁmporlfromﬁSV HiExponloCSV l

File Path

D:\megha
D:\megha
D:\megha

Source Mailbox

Kernel Office365 Migrator for Lotus Notes

o The mapping details have been successfully exported to CSV.

Target Mailbox Target Email

OK

‘ | Cancel ‘

Figure 4.31 Mapping details are successfully exported
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Server Name
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Step 4: Fill the complete details as per the following example.

D:\megha\experiment files\test file.nsf  testfile monica monica@
D:\megha\experiment files\nsf file.nsf  nsffile  sudesh kumar sudesh@
‘D:\megha\experiment files\LAB-TEST.nsf LAB-TEST tarun kumar tarun@si

34

.onmicrosoft.com

.onmicrosoft.com

inmicrosoft.com

Figure 4.32 Fulfill the complete details

Step 5: Now, click Import from CSV button to bring the fulfilled details. Browse the CSV file in which you have filled

details.
Mapping
| File Tools Help
‘ G} @ (®) Map using CSV Downlcad sample CSV
| () Map automatically
Get Target Mailbox List
o Step 1

Please select NSF file(s)

Mapping I Ilpport f}oméé\;" | E);ngtio CSV 7:

ffice365 Migrator for Lotus Notes

emove ][ Preview

or Domino file(s) to

File Path Source Mailbox Target Mailbox
convert

D:\meghatexperiment files\test file.nsf  test file

D:\megha‘experiment files\nsf file.nsf nsf file

D:\meghatexperiment files\LAB-TEST... LAB-TEST

single NSF

only)

ve folder in
r Mailbox

Target Email

Server Name

KernN

Han
=

0K Cancel
www.nucleustechnologies.com

Figure 4.33 Import from CSV to add details

Step 6: Source and Destination mailboxes are perfectly mapped. Click OK.
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F = =)
K] Mapping
File Tools Help
(®) Map using C5V Download sample CSV
G} @ 3 ffice365 Migrator for Lotus Notes
() Map automatically
Get Target Mailbox List ) |
5] Step) Mapping Import from CSY Export to CSY EILOVE ‘ ’ Preview
Please select NSF file(s) 7N
:;’E)\?er':mo file(s) to File Path Source Mailbox Target Mailbox Target Email Server Name
D:\meghatexperiment files\test file.nsf  test file mohica monica@ sh!
Step 2 D:“meghatexperiment files\nsf file.nsf nsf file sudesh kumar sudesh@ zh
D:\meghatexperiment files\LAB-TEST... LAB-TEST tarun kumar taruni@si .0l

Kernel

Migrate '

Cancel

www.nucleustechnologies.com CAP [NUM |SCRL 2

Figure 4.34 Complete data is imported

4.3.1 Restrictions of CSV File
There are few restrictions with CSV file:

File Path:

1. Provide correct source path of the NSF File in CSV (for example, if NSF file is located in a folder inside ‘C’ drive
then file path should be “C:\Folder Name\file name”.

2. Provide correct NSF file name with extension in CSV file (for example, if NSF file name is abc, then file name
should be “abc.nsf”).

User ID of Office 365:
1. There should be valid User ID.

2. User ID name should be correct.

5. Conclusion

The Configuration Manual is handy to configure and use the program to migrate NSF data from Lotus Notes and Domino
Server to Office 365. Learn more about the product and its benefits here:
https://www.nucleustechnologies.com/lotus-notes-to-office365.html

KERNEL /i
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6. Support

Connect to our experts immediately while facing any issues during installation, configuration, or associated matters.

Product Experts Technical Gurus

USA/Canada: +1-800-814-0578 USA/Canada: +1-800-814-0578
UK/Europe: +44 (0) -845-594-3766 UK/Europe: +44(0)-800-088-5478

Rest of the World: +91 (0) -991-004-9028 Rest of the World: +91(0)-991-085-4291

Additionally, you can connect with us at https://www.nucleustechnologies.com/Contact.html to submit your query, or
chat with one of our support team.

Moreover, you can write to us to the following email addresses:

* sales@nucleustechnologies.com (for Sales Queries)

* support@nucleustechnologies.com (for Support Queries)

7. Copyright

KernelApps Private Limited accompanied Installation & configuration manual, and documentation are copyright
of KernelApps Private Limited, with all rights reserved. Under the copyright laws, this user manual cannot be
reproduced in any form without the prior written permission of KernelApps Private Limited. NoPatent Liability is
assumed, with respect to the use of the information contained herein.

© KernelApps Private Limited. All rights reserved.
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